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Microsoft Access – Creating relational databases 
 
What is a Database? 
The computer's fast retrieval and large storage capabilities make it an ideal tool for managing information 
in the form of a database. Many historians refer to our present time as the "Information Age" primarily be-
cause of the ability databases have given us to store and manipulate huge amounts of information. 
A database is an application that is used to organize and store related data. For example, a company's 
inventory, customer information, and order information can all be organized into a database. A database 
stores digital information including text, numerical data, photos and graphics, sound files, e-mail addresses, 
and hyperlinks. 
 
A database can store millions of pieces of data in the relatively small area of a hard disk. If paper forms 
were used to store this information, numerous file cabinets would be required. The data in a database can 
also be retrieved quickly. For example, in less than a second, a specific order from three months ago can be 
retrieved from a company's database. If paper forms had to be searched for this particular order, it could 
take hours. Additionally, a database can easily reorganize data and present it in many different ways for 
data analysis. 
 
The Relational Database 
The relational database is a type of database commonly used by companies and other organizations. In a 
relational database, data is separated into tables that consist of records. A record is a set of data about one 
item, where each piece of data corresponds to a field. For example, Pack Suppliers, Inc. uses a relational 
database that contains a table for inventory, another for customer information, and a third for transactions. 
 

 
A table can only contain unique records, meaning that no two records can be exactly the same. The Packs 
table below contains seven records: 

 
The data stored in an individual field of a single record is called an entry. For example, blue is the Color 
field entry for the first record. The ItemNumber field contains only unique entries and is the primary key   
of the table. The primary key is a field designated to have unique entries in order to make each record of a 
table unique. The primary key may also be a combination of fields designated to have a unique 
combination of entries. 
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Defining Fields 
A field is defined by its name, type, size, and format. A well designed database has fields that store one 
piece of data only. For example, a field named FullName that stores both a first and last name is considered 
poor design. A better design would include FirstName and LastName fields to separate name data. 
A field's name should be descriptive of its contents. The following guidelines should be followed when 
choosing field names: 

• Make field names within a table unique. Access does not allow duplicate field names within a 
table. For example, two fields named Address in the same table is not permitted. 
• Choose the shortest possible name that accurately describes the contents of the field. In 
Access, field names may be up to 64 characters. When multiple words are used for a field name, 
each word should begin with an uppercase letter and as a matter of good design, the field name 
should not contain spaces. For example, in the Packs table above ItemNumber is a field name that 
contains multiple words but no spaces. 
• Use complete words instead of numbers or abbreviations. For example, FirstName is better 
than LstName or FName. 

 
Fields are classified by the type of data they store: 

• text fields store characters (letters, symbols, words, a combination of letters and numbers, etc.). 
• number fields store only numeric values. 
• date/time fields store a date or time. 
• currency fields store dollar amounts. 
• memo fields store several lines of text. 
• AutoNumber fields are automatically given a numeric entry that is one greater than that in the 
last record added. An AutoNumber field is often used as the primary key for a table since each en-
try is automatically unique. 
 

The size of a field is the number of characters or the type of number it can store. Text fields can store up to 
255 characters. A number field's size is defined by the type of value it stores. For fields that store a number 
with a decimal portion the field size single is used. Fields that store only whole numbers use the long 
integer field size. A size cannot be defined for date/time fields. 
 
The format of a field is the way in which its contents are displayed. Numeric field formats include: 

• general number is the default and displays the number exactly as entered. 
• fixed displays a field's entry to a specified number of decimal places. 
• percent multiplies the value entered by 100 and displays it with a % sign. 
• standard displays a field's entry with the thousands separator, usually a comma. 

Date/time field formats include: 
• short form (6/24/00; 10:12) 
• medium form (24-June-OO; 10:12 AM) 
• long form (Saturday, June 24, 2000; 10:12:30 AM) 

Text and memo fields usually have no format 
 
Decimal places can be set as appropriate for numeric field types. A number field with the size long integer 
should have the number of decimal places set to 0. A number greater than 0 results in the entry being 
rounded.  
 
Creating a Table 
A table is created in a relational database by first clicking on the Tables button in the Objects list in the 
Database window. Next, double-clicking on the Create table in Design view icon displays a new table in 
Design view where fields can be defined. In the table below, several fields have already been defined. The 
ItemNumber field currently contains the cursor and its field properties are shown at the bottom of the 
window: 
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This table is displayed in Design view where fields are defined 

 
 
The steps for defining a field in Design view are: 
 
1. Enter the field name. In the first empty Field Name box, type the field's name. 
2. Select the field type. In the corresponding Data Type box, select the appropriate type from the 
collapsible list. 
3. Enter a description. In the corresponding Description box, type a description of the data expected in 
that field. A field's description is displayed when records are being entered, which helps the user 
understand what kind of entry is expected. 
4. Enter the field size. In the Field Properties part of the window, enter the appropriate Field Size. (Be sure 
the General tab has been selected.) For a text field, type the greatest number of characters allowed in the 
field entry. For a number field, click in the Field Size box and from the collapsible list select either Long 
Integer or Single. A date/time field does not have a field size. 
5. Select a field format. In the Field Properties part of the window, enter the appropriate Format. (Be sure 
the General tab has been selected.) For number and date/time fields, click in the Format box and from the 
collapsible list select the desired format. Text and memo fields do not have a format. 
6. Designate the number of decimal places. In the Field Properties part of the window, enter the 
appropriate Decimal Places to be displayed. (Be sure the General tab has been selected.) Only single 
number and currency fields have decimal places. 
 
To complete the table, a primary key must be selected. The primary key is designated by first making the 
desired field active. The active field contains the cursor and has the  symbol to the left of its row. Next, 

the Primary Key button  on the Toolbar is clicked or the Primary Key command from the Edit menu is 

selected. For the Packs table, ItemNumber was made the primary key, as indicated by the  marker. 
 
The primary key must have an entry for every record in the table in order to be unique. Therefore, the 
Required option in the Field Properties part of the table Design view window should be set to Yes. 
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Sometimes it is necessary to designate two fields as the primary key. The desired fields can be selected by 
clicking on the gray box to the left of the first field, holding down the Ctrl key, and then clicking on the 
gray box to the left of the second field. Next, clicking on the Primary Key button on the Toolbar selects 
both fields as the primary key. 
 
  
Saving a Table 
Access does not automatically save a new table or the modifications to an existing table. Therefore, the 

Save command (Ctrl+S) from the File menu or the Save button on the Toolbar  must be used. The first 
time a table is saved, a dialog box is displayed so that a descriptive table name can be entered. After a table 
has been saved, its name appears in Tables of the Database window. 
 
 Creating a New Form 
A form is a way to view one record of a table at a time. For example, a columnar form for the Packs table 
in the Backpacks database would look 
similar to: 

 
A form displays one record at a time 

 
 

A columnar form displays a record with one field right after the other in a column. A form is usually the 
best way to enter records into a table because it makes data entry less error-prone. 
 
In Access, a form can easily be created using the Form Wizard, which provides dialog boxes for selecting 
fields to be included in the form and form layout options. The steps for creating a form using the Form 
Wizard are: 
 
1. Start the Form Wizard. Click the Forms button in the Objects list in the Database window and then 
double-click on the Create form by using wizard icon to display the Form Wizard dialog box: 
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 2. Select the desired table and fields. From the Tables/Queries collapsible list, select the desired table. 
The fields from that table are displayed in the Available Fields list. A form for a table usually includes all 

the fields of that table. Click on the button to move all the fields of the selected table to the Selected 
Fields list: 
 

 
 
  

3. Select the form layout. Select the Next button to display layout options. Click on Columnar for a 
columnar form: 
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4.  Select the form style. Select the Next button to display style options for the form background. 
Click on Standard for a plain gray background: 

 
 
5. Enter the form title. Select the Next button to display the last Form Wizard dialog box where a 
form title can be entered and the option to open the form for data entry can be selected: 

  
 
6. Display the form. Select the Finish button to display the new form. 
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Using Forms and Entering Records 
Record controls are displayed at the bottom of a form. The number of the active record and the total 
number of records in the table are displayed next to controls that scroll records: 

 
 

  displays the first record. 
  displays the last record. 
  displays the next record. 

  displays the previous record. 
 
If a table contains no data, then its corresponding form will display an empty record with empty entry 
boxes for all but number fields. A number field entry box automatically displays a 0 until it is replaced by 
another entry. AutoNumber field entries are not displayed until another entry of the record is entered. 
 
A record is added to a database by typing entries into a form. The pointer can be clicked in the desired 
entry box to move the cursor to that box. However, data entry is usually faster when your hands are kept on 
the keyboard. In this case, the Enter key or the Tab key can be pressed to move the cursor from entry box to 
entry box. Pressing Shift+Tab moves the cursor to the previous field in the record. When the cursor is in the 
last field of a record, pressing Enter or Tab displays the next record in the table, if there is one, or an empty 
record otherwise. 
 
To change an existing entry, the cursor must first be moved to that entry and then the entry edited. 
 
 
Modifying a Table 
A table can be modified by adding a new field, renaming a field, or deleting a field. Modifications to a table 
should be done in Design view. 
 
A table is displayed in Design view by clicking on the Tables button in the Database window, clicking once 
on the desired table name, and then clicking on the Design button at the top of the Database window. A 
displayed table can be switched between Design view and Datasheet view by clicking the View button 

  on the Toolbar. 
 
A field is renamed by placing the cursor in the appropriate Field Name box in Design view, editing the 
existing text, and then pressing Enter. 
 
A field is added to a table by entering the field's name, type, and description in the first blank row after the 
last field in Design view. Next, the field's size, format, and decimal places, if necessary, are defined in the 
Field Properties part of the window. 
 
A field is deleted by right-clicking on the desired field name in Design view and then selecting the Delete 
Rows command from the pop-up menu, which displays a warning dialog box: 

  
 

Access warns you when a field is about to be deleted 
Selecting Yes removes the field and any data in that field from every record in the table. Selecting No 
retains the field. 
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When the fields of a table have been modified, the table's corresponding form must be updated. The best 
way to update a form is to create a new one. After creating the new form it should be saved with the same 
name as the original, which will cause Access to display a message asking if you want to replace the 
existing form. Selecting Yes replaces the existing form with the new, updated form. 
 
Sorting Records 
Placing records in a specified order is called sorting. In Access, records can be sorted in either ascending or 
descending order based on the entries of a specified field. Ascending order is also called alphabetical order 
when the entries are text, and chronological order when the entries are times or dates. 

The Sort Ascending  and Sort Descending  buttons on the Toolbar are used to sort records. When 
the desired Sort button is clicked, records are ordered based on the entries of the field that contains the 
cursor. For example, to place the records in the Packs table in alphabetical order by color, an entry in the 
Color field is clicked to place the cursor in that field. Next, clicking the Sort Ascending button orders the 
records based on color. 
 
Sorting the records of a table does not affect the order of records in a form. The records in a form are 
ordered by clicking on the desired entry and then clicking the appropriate Sort button. 
 
The Sort Ascending and Sort Descending commands in the Sort submenu from the Records menu can also 
be used to sort records. 

 
Modifying Records 
Modifying records includes adding new records, changing the entries in existing records, and deleting 
records. Records should be modified using the appropriate form because a form displays only one record at 
a time, which may reduce errors. 

A new record is added by clicking the  record control at the bottom of a form to display a blank record. 
Next, the entries of the new record are typed. 
 
Changing the entries in an existing record is called updating. The record controls at the bottom of a form 
can be used to scroll the records until the record for updating is displayed. Alternatively, a filter may be  
applied to quickly find the record for updating. A displayed record is updated by double-clicking the 
desired entry and then typing to replace the existing entry. An entry can be edited by clicking once on the 
desired entry to place the cursor. 

The Delete Record button on the Toolbar is used to delete the record displayed by a form. The Delete 
Record command from the Edit menu may also be used. To display the appropriate record for deleting, the 
record controls at the bottom of a form are used to scroll the records. When Delete Record is executed. 
Access displays a warning dialog box: 

 
Selecting Yes removes the active record. Selecting No retains the record. 
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Select Queries 
Another way to view data in a relational database is by applying a select query. A select query can include 
fields from any table and uses the relationships between tables to determine which data to display. The 
results of a select query are displayed in a datasheet, 
The steps for creating a select query in Design view are listed on the next page. Throughout the steps, a 
query for adult pack sales for the Back-packs database is created. 
 
1. Display a new select query in Design view. Click the Queries button in the Objects list in the Database 
window and then double-click on the Create query in Design view icon to display the Select Query window 
and the Show Table dialog box: 

 
 
 
 2. Add the required tables to the select query. In the Show Table dialog box, click on the appropriate 
table name and then select the Add button for each table needed by the query: 

   
Note the line indicating that the tables are related.  

The tables in a select query must be related for the query to work properly. 
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3. Add fields to the design grid. The design grid is where fields to be displayed by the select query must 
appear. To add a field to the design grid, drag it from the table to the desired Field box in the design grid, or 
click in the desired Field box and select the field from the collapsible list: 

 
   
4. Enter the criteria. The Criteria line is where criteria is typed: 

 
  

5. Display the query results. Click the Run button on the Toolbar or select the Run command from the 
Query menu. The select query results are shown in Datasheet view: 

 
  
6. Save the select query. With the query datasheet displayed, select the Save command from the File menu 
to display the Save As dialog box. Type a descriptive name in the Query Name entry box and select OK. 
 
After saving a select query, it can be applied by clicking on the Queries button in the Objects list in the 
Database window and then double-clicking the desired select query name. 
 
  



access.doc                                                                                                                                                                 Page 11 
Adapted from A Guide to Microsoft Office 2000 Professional 

 
Reports 
A report is used to print information from a relational database in an organized manner. A descriptive title 
and headings are also included on a report. For example, an informative sales report from the Pack 
Suppliers database looks similar to: 

 
Page 1 of Pack Suppliers sales report 

 
A report can include any combination of fields because Access uses the relationships between tables to 
determine which entries to display. In addition, reports are useful for creating a formatted printout of a 
database table, and are also a good way to print the results of a select query. Any changes made to the 
tables or queries used in a report are automatically reflected the next time the report is displayed. 
  
Creating a Report 
In Access, a report can easily be created using the Report Wizard, which provides dialog boxes for 
selecting fields to be included in the report and report formatting options. The steps for creating a report 
using the Report Wizard are listed below. Throughout the steps, the sales report for Pack Suppliers is 
created. 
 
1. Start the Report Wizard. Click on the Reports button in the Objects list in the Database window and 
then double-click on the Create report by using wizard icon to display the Report Wizard dialog box: 
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 2. Add the desired fields to the report. Select the desired table or query from the Tables/Queries 
collapsible list. In the Available Fields list click on the desired field name and then click on the button 
to move the field name to the Selected Fields list. Repeat this process to add each of the desired fields to 

the report. To add all the fields in the list, click on the button. For the Pack Suppliers sales report, the 
selected fields are: 

 
3. Select the grouping of the data. Select the Next button to display the next Report Wizard dialog box. 
Selecting a field and then the button groups the data in the report by this field's entries. For the Pack 
Suppliers report/ the report is grouped on ItemName: 

 
 

Grouping data can eliminate displaying duplicate entries and make a report more readable. 
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4. Select the sort order. Select the Next button to display the next Report Wizard dialog box. A report can 
be sorted based on a field's entries. For the Pack Suppliers report, the Style field is used to sort the report: 
 

 
 
The button to the right of the sort field indicates the sort order. In this case, ascending. Clicking on this sort 
button reverses the sort order to descending. 
 
5. Select the layout. Select the Next button to display the next Re-port Wizard dialog box. Clicking on a 
Layout option shows its corresponding layout in the left side of the dialog box. For the Pack Suppliers 
report, the default Stepped layout is selected: 
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The Orientation options change the way the report will be printed. If many fields are included in the report, 
the Landscape option should be selected to display the report data across the widest part of the page. This 
will prevent data from being cutoff when printed. 
 
 6. Select the report style. Select the Next button to display the next Report Wizard dialog box. Here, the 
style of the report is chosen. For the Pack Suppliers report, the default Corporate style is selected: 

 
7. Enter the report title. Select the Next button to display the last Report Wizard dialog box where a 
report title is typed and the option to preview the report can be selected: 

 
   
 8. Display the report. Select the Finish button to display the new report. Clicking on the displayed report 
alternates between magnified and full-page views.  The Report Wizard is a simple, fast way to create a 
report. To determine the best presentation for your data, experiment with grouping, sorting, layouts, and 
styles. 
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Exercise:  The Department head wants to use a relational database to store information on the student 
workers address and payroll information. 
 

a) Using Access, create a relational database naming it Students. 
b) Create a table that will store information on the student workers. After defining the fields below, 

save the table naming it Student: 
Field Name     Type     Caption                    Size 
student_id   Text Student ID                   3  
first_name      Text     First name       15  
last_name      Text     Last name       30  
address       Text     Street address        50  
city           Text     City         15  
state          Text     State          2  
zip            Text     Zip code                10  Input mask for formatting … 
phone         Text     Phone number        14 Input mask for formatting … 
 

c) Create a table that will store information on the payroll history. After defining the fields below, 
save the table naming it Payroll: 
Field Name     Type         Caption             Size    Format      Decimals 
student_id    Text         Student ID              3  
check_date       Date/Time    Date of paycheck               Short Date Format  

      Input mask for formatting  
gross_pay       Currency      Gross pay                                2  
taxes          Currency     Tax deductions                                    2 
 
The primary key for the Payroll table is the student_id and check_date fields together. This is 
because there can only be one record for a specific student on a specific date. 
 

d) Create a form named Student for the Student table and enter the following five records: 
001; Alan; White; 430 First Avenue; Atlanta; GA; 30303-1234; (678) 555-1234  
002; Betty; Baker; 100 Broad Street; Atlanta; GA; 30303-5555; (678) 555-0789  
003; Rita; Brown; 12300 Peach Street; Atlanta; GA; 30303-0009; (404) 555-2323  
004; Gary; Smith; 123 Park Avenue; Atlanta; GA; 30303-8806; (770) 555-6932  
005; Frank; Wells; 625 48th Avenue; Atlanta; GA; 30303-0001; (770) 555-3000 
 

e) Create a form named Payroll for the Payroll table and enter the following ten records: 
001; 3/13/01; 244; 36.60 
001; 3/20/01; 257; 38.10 
002; 3/20/01; 191.67; 28.75 
002; 3/27/01; 210.75; 31.50 
003; 3/6/01; 175; 26.25 
003; 3/13/01; 180; 27 
004; 3/6/01; 210.24; 31.53 
004; 3/13/01; 225.64; 33.84 
005; 3/13/01; 187.82; 28.17 
005; 3/20/01; 195.25; 29.28 
 

Create Queries: 
a) The Student and Payroll tables are related by the student_id field. Create the appropriate 

relationship between the Student and Payroll tables. 
b) Create a select query that displays the first_name, last_name, check_date, gross_pay, and 

taxes fields of all those employees whose gross pay is less than $250(< $250 ) and taxes are 
less than $30 (< $30). Save the select query naming it Gross_pay  & Taxes.  

 
Create Reports: 
 

a) Create a report that displays the last_name, first_name, address, city, state, and zip fields from 
the Student table. Sort the report on the last_name field in ascending order. Select appropriate 
layout and style options. Title the report Student Workers. 


